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ABSTRACT: Every building has got its form, function and aesthetics. We consider that the Architects will 

take of them and the structural engineer will be responsible for strength and safety of structure. A building 

or structure should be constructed according to Indian Standard specified by the concerned department. 

Generally, there are different types of buildings such as Residential, Commercial centers, Offices and 

Educational and Institutional buildings, Government offices, etc. STAAD.Pro allows structural engineers 

to analyses and design virtually any type of structure through its flexible modelling environment, advanced 

features and fluent data collaboration.  In this project we have designed a Primary health center building 

(RCC) using STAAD.Pro V8i which includes design of constituent elements such as slabs, beams, columns 

and footings. Study of loads acting on building and R.C.C design with reference to IS875 and IS456-2000. 

We conclude that Staad pro is a very powerful tool which can save much time and is very accurate in 

Designs.  Primary Health Centre (PHCs), sometimes referred to as public health centers, are state-owned 

rural health care facilities in India. They are essentially single-physician clinics usually with facilities for 

minor surgeries, too. They are part of the government-funded public health system in India and are the 

most basic units of this system. Presently there are 25,308 PHCs in India. Thus, it is concluded that Staad 

pro package is suitable for the design of a multistoried building 

KEYWORDS: IS Codes, Staad Pro V8i 

INTRODUCTION 

A civil engineer is responsible for planning and designing a project, constructing the project to the required scale, 

and maintenance of the product. A civil engineer requires not only a high standard of engineering knowledge but 

also supervisory and administrative skills. The planning part of their work involves site investigation, feasibility 

studies, creating solutions to complications that may occur and the actual designing of structures. They have to 

work with the guidelines of the local government authority and get plans approved by the relevant authority. They 

may prepare cost estimates and set construction schedules. Construction work involves dealing with clients, 

architects, government officials, contactors and the supervision of work according to standards. Their work also 

involves the maintenance and repair of the project. 

The major specializations within civil engineering are structural, water resources, environmental, construction, 

transportation, geo-technical engineering etc. On most projects, civil engineers work in teams or in coordination 

with many other engineers. They can find work as a supervisor of a construction site or a managerial position or 

in design, research as well as teaching in government services or private concerns. They can also work as 

independent consultants. 
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National Building Code (NBC- Indian standard codes) is a document containing standardized requirement for the 

design & construction of most of types of building in the Country. Although codes may sometimes seem fussy, 

they are the result of years of experience and testing. Building codes exist to protect the public's health, Safety 

and welfare, National Building Code (NBC) regulates building construction & building use in order to protect the 

health, safety & welfare of the occupant. One should always take the correct precautionary measures to assure the 

safety of Occupants. 

Any Civil engineering project the main three important activities 

 Planning 

 Structural analysis and Designing 

 Construction 

Planning  

 This phase considers the functional, social and financial requirements of the users besides the other 

factors that affect the general layout and dimensions of the structure.  

 In the planning phase several trials are made to achieve the best possible solution after considering all 

the constrains. 

 The constraints that need consideration could be on aesthetical, sociological, legal, financial, 

environmental and resource conservation aspects 

 All the activities connected with the project are so coordinated    and carried out that its completion time 

is reduced to an optimum value. A well-planned structure will always be structurally safe, functionally 

sound and financially cheapest 

Structural analysis and Designing 

 Once the planning of a structure is completed the design phase begins. 

 The basic need of a good design is to arrive at suitable dimensions for different components of a structure 

selected after the planning phase, using the structural material of the known load-deformation behavior. 

 From the preliminary design of the various alternatives, as proposed in the planning phase, the best 

solution is identified after considering the overall structural soundness, resource availability, material 

durability and the overall cost. Form the solution so identified final design of the member is then made.  

LITERATURE REVIEW 

A Study on Market Orientation and Service Quality in Primary Hospital in Telangana State”  

Sampling Methods  

Two stage sampling method is used, first Quata Sampling and then Convenience sampling. As sample unit in 

health care do not constitute a homogeneous group so for better analysis different geographical region are selected 

in Telangana state, quota sampling is used. The sample items are selected using Convenience sampling. To obtain 
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better representation of the population, samples are consisting of respondents from different age group, gender, 

income range, employment, marital status and education level.  

This study is limited to the Telangana state only. Keeping in view professional ethics and integrity names of the 

hospitals have been kept in abeyance.  

Sources of data  

Secondary Data: For conceptual clarity information that is obtained from previously published materials such as 

books, magazines, journals, health care publications and websites.  

Primary data: Information will be gathered using Structured Questionnaires as the survey instrument.  

Research objectives  

The increasing perception of quality of services in healthcare customers’ systematic demands and hospital core 

performance leads to an increasing concern for understanding patient/consumers and patient/consumer families’ 

needs in a hospital environment. In fact, given the humanitarian nature of health services, patient/consumer 

satisfaction in healthcare is not only important for the sustained profitability or survival of the hospital, but also 

for increased effectiveness and efficiency, and for better treatment outcomes. Healthcare organizations, 

specifically hospitals, are continuously trying to improve on their image and their services.  

The present study explores the relationships among market orientation and quality of services in multi-specialty 

hospitals.  

 To study market orientation practices of selected multi-specialty hospitals in Telangana state.  

 To study service quality dimensions of selected multi-specialty hospitals in Telangana State.  

 To study the impact of market orientation practices on service quality dimensions of multi-specialty 

hospitals in Telangana state.  

 To assess how demographic and other factors are affecting on perceptions of quality of services in multi-

specialty hospitals in Telangana State.  

STRUCTURAL ANALYSISING AND DESIGN (STAAD PRO) 

Use of Computer in Structural Designing of Buildings  

In earlier periods say in sixties, engineering calculations were done by slide rules. Then in seventies, came the era 

of calculators, which replaced slide rules completely. The calculators are very much in vogue these days but to 

aid the structural engineer have come computers which are high-speed calculators and much more. When similar 

members (say, slabs, beams columns, footings) are to be designed, relevant computer programs can be used to get 

more accurate methods which were earlier difficult and time-consuming to use manually. For example, frames 

under horizontal loads were analyzed by portal or cantilever methods manually. These gave only approximate 

results and we had to be satisfied with them. But now, computer can be used effectively to get accurate results.  
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Computer-Aided Analysis & Design: -  

Computers have recently been brought in to aid structural designers. These machines are as effective as the 

available software (i.e. computer programs). Programs are available for design of slabs, simply supported and 

continuous beams. Columns under biaxial bending isolated footings, combined footings and rafts. There are also 

available 2-D plane frame programs, grids, retaining walls, etc. not only all the available programs may be to the 

liking of a designer. The assumptions made in the development of some programs may not be acceptable to the 

structural designer and in one case, it was found that the column program purchased was valid only for short 

columns and not for long columns, although at the time of purchase, it was claimed to be valid for both short and 

ling columns.  

In practice, continuous beams, frame analysis under horizontal loads are almost always solved by a computer. 

Sometimes, a building is divided into frames in both the principal directions. All the frames with the vertical and 

the horizontal loads are put in the computer and the solution is got which includes the complete design of beams 

at all the floor levels. Column loads are then assembled manually. Column design under biaxial bending at all 

levels is done by a computer program.  

A very powerful program STAAD Pro is also available in the market which can be used for 3-D analysis of a 

building as a whole. It is useful for analysis and design of multi-storied buildings. We may consider the followings 

methods of approach in order to tap the full capacity of STAAD Pro software 

Structural Design Using STAAD- PRO  

“Concurrent Engineering” based user environment for model development, analysis, design, visualization and 

verification.  

Full range of analysis including static, P-delta, pushover, response spectrum, time history, cable (linear and non-

linear), buckling and steel, concrete and timber design.  

Comparison  

 Limitations of Hand Computation Methods  

 Applicable for small problems  

 Tedious for even medium sized problems  

 3-d analysis almost impossible  

Advantage for Invention of Computer  

 Matrix methods of structural analysis  

 Development of numerical techniques  
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 Finite element method  

Programming languages developed  

 Object-oriented intuitive 2D/3D graphical model generation.  

 Pull down menus, floating tool bars, and tool tip help.  

 Quick data input through property sheets and spreadsheets.  

 Customizable structural templates for creating a model.  

 Complete support of VBA macros for customization (integrate with Match CDA or Excel).  

 Supports truss and beam members, plates, solids, linear and non-linear cables and curvilinear beams.  

 Advance automatic load generation facilities for wind, snow, area, floor and moving loads.  

 Flexible zoom, pan and multiple views.  

 Isometric and perspective view and 3D shapes.  

 Toggle display of loads, supports, properties, joints, members, etc. Built-in command files editor for text 

editing.  

 State-of-the-art graphical pre and post processors.  

 Rectangular/cylindrical coordinate systems with mix and match capabilities.  

 Joint, member/element, mesh generation with flexible user- Controlled numbering scheme.  

 Import/Export DSF, DWG, VRML, CIS/2 and Excel files.  

 Efficient algorithm minimizes disk space requirements.  

 FPS, metric or SI units.  

 Presentation quality printer plots of geometry and results as part of run output.  

 

STAGES IN STRUCTURAL DESIGN: 

The process of structural design involves the following stages. 

1. Structural planning. 

2. Action of forces and computation of loads. 

3. Methods of analysis. 

4. Member design. 

5. Detailing, Drawing and Preparation of schedules. 

 

STRUCTURAL PLANNING: 

After getting an architectural plan of the buildings, the structural planning of the building frame is done. This 

involves determination of the following. 

a. Position and orientation of columns. 

b. Positioning of beams. 

c. Spanning of slabs. 

d. Layouts of stairs. 

e. Selecting proper type of footing. 
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Positioning and orientation of columns: 

Following are some of the building principles, which help in deciding the columns positions. 

 

Positioning 

1. Columns should preferably be located at (or) near the corners of a building, and at the intersection of 

beams/walls. 

2. Select the position of columns so as to reduce bending moments in beams. 

3. Avoid larger spans of beams. 

4. Avoid larger center-to-center distance between columns. 

5. Columns on property line. 

 

Orientation of columns: 

 

Avoid projection of columns: 

The projection of columns outside the wall in the room should be avoided as they not only give bad appearance 

but also obstruct the use of floor space, creating problems in placing furniture flush with the wall. The width of 

the column is required to be kept not less than 200mm to prevent the column from being slender. The spacing of 

the column should be considerably reduced so that the load on column on each floor is less and the necessity of 

large sections for columns does not arise. 

 

Orient the column so that the depth of the column is contained in the major plane of bending or is 

perpendicular to the major axis of bending. 

This is provided to increase moment of inertia and hence greater moment resisting capacity. It will also reduce 

Leff/d ratio resulting in increase in the load carrying capacity of the column. 

 

POSITIONING OF BEAMS: 

1. Beams shall normally be provided under the walls or below a heavy concentrated   load to avoid these 
loads directly coming on slabs. 

2. Avoid larger spacing of beams from deflection and cracking criteria. (The deflection varies directly 
with the cube of the span and inversely with the cube of the depth i.e. L3/D3. Consequently, increase in 
span L which results in greater deflection for larger span). 
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Fig. Showing the typical column layout G+2 RC Framed Building 

 

Column – 230 x 380 mm 

 

 

Fig. Showing the Ground floor Beam Layout of G+2 RC Framed Building 

 

Fig. Showing the First Floor/Second Floor Beam Layout of G+2 RC Framed Building 
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 Beam – 300 x 450 mm 

 

FOOTING: 

The type of footing depends upon the load carried by the column and the bearing capacity of the supporting soil. 

The soil under the foundation is more susceptible to large variations. Even under one small building the soil may 

vary from soft clay to a hard murmur. The nature and properties of soil may change with season and weather, like 

swelling in wet weather. Increase in moisture content results in substantial loss of bearing capacity in case of 

certain soils which may lead to differential settlements. It is necessary to conduct the survey in the areas for soil 

properties. For framed structure, isolated column footings are normally preferred except in case of exists for great 

depths, pile foundations can be an appropriate choice. If columns are very closely spaced and bearing capacity of 

the soil is low, raft foundation can be an alternative solution. For column on the boundary line, a combined footing 

or a raft footing may be provided. 

TYPES OF LOADS: 

The loads are broadly classified as vertical loads, horizontal loads and longitudinal loads. The vertical loads 

consist of dead load, live load and impact load. The horizontal loads comprise of wind load and earthquake load. 

The longitudinal loads i.e., tractive and braking forces are considered in special case of design of bridges, gantry 

girders etc. 

 

Fig. Showing the 3D View of G+2 Building 

Dead load: 

Dead loads are permanent or stationary loads which are transferred to structure throughout the life span. Dead 

load is primarily due to self-weight of structural members, permanent partition walls, fixed permanent 

equipment’s and weight of different materials. 

Load calculations 
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Self - weight of Slab load: 

Floor loads for 150mm thick slab 

Thickness of slab -150mm 

Unit weight of reinforced concrete - 25.00kn/m3 

= 0.15 x 1x 25 

= 3.75 KN/m2      

Dead load of slab= 3.75kn/m2 

Floor finishes     = 1.50kn/ m2 

         = 3.75 x 1. 5 = 5.25 Kn/m2 

Total load of slab =   5.25kn/ m2 

Self-weight of Beam Load: 

Beam Size- 300x450mm 

Unit weight of reinforced concrete - 25.00kn/m3 

   = 0.3 x 0.45 x 25 

  = 3.375Kn/m3 

Wall loads 

External Wall 

230mm thick wall for 3.5 heights 

Thickness of wall ‘b’ - 0.23m 

Height of walls ‘h’ - 3.5mm 

Unit weight of brick masonry γ - 19.2kN/m3 

     = 0.23 x 3.5 x 19.2  

Total load h*b* γ   = -15.456 kN/m3 

Internal or Partition Walls 

150mm thick wall for height 3.5m  
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Thickness of wall ‘b’ - 0.15m 

Height of walls ‘h’ - 3.5m 

Unit weight of brick masonry ‘γ’ - 19.2kN/m3 

= 0.15 x 3.5 x 19.2 

Total load h*b* γ = -10.08 kN/m3 

Parapet & Balcony wall load 

Thickness of wall ‘b’  - 0.115m 

Parapet wall ‘h’ - 1.00m 

Unit weight of brick masonry ‘γ’ - 19.20kn/m3 

    = 0.115 x 1 x 19.2 

Total load    h*b* γ  = 2.208 kn/m3 

 

Fig. Showing the Dead load Application G+3 Building 
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Imposed loads or live loads: 

Live loads are either movable or moving loads without any acceleration or impact. There are assumed to be 

produced by the intended use or occupancy of the building including weights of movable partitions or furniture 

etc. The floor slabs have to be designed to carry either uniformly distributed loads or concentrated loads whichever 

produce greater stresses in the part under consideration. Since it is unlikely that any one particular time all floors 

will not be simultaneously carrying maximum loading, the code permits some reduction in imposed loads in 

designing columns, load bearing walls, piers supports and foundations. 

Impact loads: 

Impact load is caused by vibration or impact or acceleration. Thus, impact load is equal to imposed load 

incremented by some percentage called impact factor or impact allowance depending upon the intensity of impact. 

 

Live load as per Code IS: 875 (Part-2) 

Patient rooms  - 4.000kn/ m2 

Stair case, corridor - 3.000kn/ m2 

Terrace, portico - 2.000kn/ m2 

 

Fig. Showing the live load Application G+2 Building 

 

Wind loads: 
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Wind load is primarily horizontal load caused by the movement of air relative to earth. Wind load is required to 

be considered in design especially when the heath of the building exceeds two times the dimensions transverse to 

the exposed wind surface. For low rise building say up to four to five story’s, the wind load is not critical because 

the moment of resistance provided by the continuity of floor system to column connection and walls provided 

between columns are sufficient to accommodate the effect of these forces. Further in limit state method the factor 

for design load is reduced to 1.2 (DL+LL+WL) when wind is considered as against the factor of 1.5(DL+LL) 

when wind is not considered. IS 1893 (part 3) code book is to be used for design purpose. 

Design Wind Speed Vz = Vb x K1 x K2 x K3 

Where 

Vb- Design Wind speed 

K1- Probability factor 

K2 – Terrain factor 

K3- Topography Factor 

Exposure factor is -1.0 (As per code) 
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Fig. Showing the wind load Application on G+2 Building

 

Fig:  Bending forces at Direction –Z & Y 

ANAYLSIS RESULTS 

Load combination:  

The structure has been analyzed for load combinations considering all the previous loads in proper ratio. In the 

first case a combination of self-weight, dead load and live load (1.5(DL+LL)) was taken in to consideration. In 

the second combination case instead of wind load seismic load was taken into consideration.   

 

Performing Analysis/Design 

STAAD.Pro performs Analysis and Design simultaneously. In order to perform Analysis and Design, select the 

Run Analysis option from the Analyze menu.  

 

Fig: Run Analysis 

If the structure has not been saved after the last change was made, you should save the structure first by using the 

Save command from the File menu. 

When you select the Run Analysis option from the Analyze menu, the following dialog box appears: 
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Click on the Run Analysis button. 

As the analysis progresses, several messages appear on the screen as shown in the figure below.  

 

Frame A  

 

 

Bending Moment Frame A 
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Shear Force Frame A 
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Axial force of a Frame A 

 

Deflection of Frame A 

 

Bending Moment of Whole Structure 
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Shear Force of Whole Structure 

 

Axial Force of Whole Structure 
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Deflection of Whole Structure 

After doing all the structural analysis of our structure, we have designed it to find out the steel used for the 

reinforcement for the columns and beams. 

By selecting the code IS: 456 2000 for the concrete design we will then define parameters for our design as: 

 

Fig: Torsional Force and Beam Stress on G+2 Primary Hospital Building 

CONCLUSION 

The empirical evidence examined in the research suggests that the notions of therapeutic or patient-friendly 

environments held by participants in the study were based upon three conceptual visions of the role and function 

of the built environments of health care facilities. They are: the notion of homeliness, the notion of physical and 

visual clarity and accessibility through the spaces, and the notion of supportive environments as discussed in the 
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answers to the research questions below. The program contains a number of parameters which are designed as per 

IS: 456 (2000).  Beams are designed for flexure, shear and torsion.  

Columns are designed for axial forces and biaxial moments at the ends. All active load cases are tested to calculate 

reinforcement. The loading which yield maximum reinforcement is called the critical load.  

We can conclude that there is theoretical and practical work done. As the scope of understanding will be much 

more when practical design work is done. We design basic structural elements (slab, beam, columns and footings). 

As we get more knowledge in such a situation where we have great experience doing the practical work 

After obtaining STAAD Analysis and Design the results are seemed to be more accurate when compared to 

manual design results. During the project work many obstacles were faced to obtain error less STAAD output. 

The future work can be carried in continuation of this work. The main drawback of STAAD is Designing slabs is 

tedious job. 
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